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1 Introduction 

1.1 Presentation of the Tutorial 

This training exercise includes a model schematisation and application of a significant 

number of add-on modules and specific features of the MIKE 11 River modelling package: 

• MIKE 11 HD 

• MIKE 11 SO 

• MIKE 11 DB 

• MIKE 11 RR 

• MIKE 11 AD 

• MIKE 11 ECO Lab 

In Section 2, you will learn how to build a simple MIKE 11 HD model. It is the basis to all 

the following exercises that use different modules of MIKE 11 and it is recommended to 

perform this part of the tutorial to start with. It is possible to skip most of the following 

exercises as most of them just use the basic setup and to concentrate on a particular 

module or exercise only.  

 

In Section 3, you will work on model stability and calibration. 

 

In Section 4, you will add simple and more advanced structures to the model (control 

structures and dam break structures). 

 

In Sections 5 and 6, you will add floodplain branches to the model and generate flood 

maps. 

 

In Section 7, you will develop a simple Rainfall-Runoff model and link it to the 

hydrodynamic model. 

 

In Section 8, you will apply the Climate Change tool to your MIKE 11 setup. 

 

In Section 9, you will work with the Advection-Dispersion module (still to come…). 

 

In Section 10, you will work with the ECO Lab module. 

 

Finally, in Section 11 you will work with the Sediment Transport module (still to come…). 
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1.2 Data for the Exercises 

The data for the exercises is found in the “Sesupe Exercise Hand-out Files” file and 

include: 

• Shape files of the Sesupe River and its tributaries 

• Various time series 

• A 90 m DEM of some part of the Sesupe catchment 

• Text files with cross section data 

• An image of the topography in the Sesupe catchment. 
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2 Model Schematisation 

The aim of the present part is to construct the base MIKE 11 model that will be used in 

the other exercises. 

 

2.1 MIKE Zero Project 

The first step in building a new model is to create a MIKE Zero project that will allow you 

to easily manage your modelling files. 

 

Start MIKE Zero. From the MIKE Zero window select File > New > Project from 

template…  

 
1. In the Project Type list, select the General Project Type, and in the Templates list, 

select the General item. Change the location of the project to your training exercise 
folder. 

 

 
 
2. Fill in the Project Name (Sesupe Exercises, for example) and the Client Name as 

indicated in the dialog and then click the [OK] button to create the project folder. The 
folder structure of the selected project template is listed under the Project Explorer 
panel on the right-hand side of the MIKE Zero window. This panel provides you with 
an easily accessible overview of the project and the files associated with the project. 

3. It is a good idea to copy all the input data for the exercises under the External Data 
folder. You can do that by right clicking on this folder and choosing Add existing files 
and then browse to the files provided for this exercise and add the files to the folder. 
Alternatively, you can simply copy all exercise data to this folder in Windows 
Explorer.  
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4. Feel free to explore more options available from the Project Explorer, but also File 
Explorer; Tool Explorer, etc. 
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2.2 Base MIKE 11 Simulation 

2.2.1 Getting started 

We will define the river model of Sesupe River using background layer files and shape 

files for generating the river branch as illustrated below. The river Sesupe flows from 

South to North and has several tributaries.  

 

 
 

The first task is to start the MIKE Zero interface and to create a new MIKE 11 simulation 

file.  

 

Select Hydrodynamic Model and set the simulation mode to unsteady. Save the MIKE 11 

simulation file under the Project Model folder. Give it a meaningful name like 

‘Sesupe_base.sim11’. 
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The next task consists in creating a new MIKE 11 network file. 

 

Set the area coordinates to those shown below. Use a NON-UTM map projection for this 

exercise: 

 

 
 

Background layers management 

To manage the background layer files, open the Layers > Add/Remove… menu and 

import the following files: 

 

• Background image file: ‘Topo_500.bmp’ 

• Shape file: ‘Sesupe_River.shp’ 

• Shape file. ‘Sesupe_River_only.shp’ 
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From the ‘Layers’|’Properties…’ menu change the layer-properties: 

 
1. For the Image file change image coordinates:  

Min cords. = (381000, 5995000) and Max cords. = (519000, 6115000) 
2. For the ‘Sesupe_river_only’ change the line-color to Red, and make the thickness = 

0.3 mm 
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Save your network file to ‘Sesupe_base.nwk11’ in your Model folder. Link the network file 

to the simulation file from the Input page of the simulation file. Save the simulation file too. 

 

 
 

2.2.2 Network digitisation 

The River network can be defined in one of the following two ways (only apply one of the 

methods):  

• Manual Digitisation (slowest method!):  

Starting at approx. x-y coordinates of (437850, 6024070) digitise the river Sesupe 

from the upstream end down to the end-point around coordinates (384793, 

6103600). Digitisation can be made on top of the red line of the shape file previously 

defined. 

• Automatic generation of network from shape file (Fastest and easiest!) 

Select ‘Network’ >’Generate Branches from Shape files…’.  

Select the option; ‘Generate points and branch’ and use the Sesupe_River_only 

shape file. Select the appropriate River name attribute (BRS_ID = ‘Sesupe’) and 

TopoID attribute (Topo_ID = ‘Sesupe’) and press OK. 
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The upstream point must defined as chainage 0 m and the downstream point as chainage 

270500 m.  

 

HINT: Change the point properties to ‘User Defined’ by opening the network Tabular View 

or double-clicking on the point in the graphical view. 
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Save the network file. 

2.2.3 Cross sections 

Create a new cross section file and enter manually the cross sections described below 

with the River name = ‘Sesupe’ and Topo-ID = ‘Sesupe’. 

 

River Sesupe 

Ch. 0 m 

River Sesupe 

Ch. 270500 m 

X [m] Z [m] X [m] Z [m] 

0.00 125.00 0.00 12.00 

2.00 123.00 2.00 10.00 

4.00 122.90 4.00 10.00 

6.00 123.00 6.00 7.50 

8.00 125.00 6.10 6.50 

  26.00 6.40 

  45.90 6.50 

  46.00 7.50 

  48.00 10.00 

  50.00 10.00 

  52.00 15.00 

 

To insert new cross sections, you can right-click in the empty panel on the left of the file 

and select ‘Insert’. 
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Update Markers for both cross sections above. 

 

 
 

Import the remaining cross sections for River Sesupe from an ASCII file, which is 

provided to you in a file named ‘Sesupe-Sections.txt’. Go to menu File > Import > Import 

Raw Data. 

 

Examine the text file with a text editor (e.g. Notepad) to view and learn about the file 

format of the MIKE 11 ASCII file for cross section data (use it for your own import of cross 

section data in coming projects!). 

 

Calculate processed data for all sections using the ‘Cross Sections’ >’Apply to all 

Sections…’ menu.  

 

In this dialog, select the Items:  

 

• Radius Type = ‘Hydraulic Radius. Total Area’;  

• Transversal Distribution = ‘Uniform’;  

• Resistance = ‘Relative Resistance’.  

• Update Marker positions (1=Left, 3= Right and 2=Bottom) and activate which 

markers you want to update (update all 3 Markers; M1, M2 and M3).  

• Select ‘Recompute All’ in the ‘Action to Be Done’ section of the dialog and press OK.  
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The Cross Section Editor will then update all the parameters as defined above and 

calculate processed data for all the cross sections in the cross section file (including the 

imported sections). 

 

Open the processed data view and view/analyse the processed data calculated. 

 

 
 

Save the cross section file in the Model folder as Sesupe_base.xns11 (or another 

meaningful name).  
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Link the cross section file to the simulation file. 

 

2.2.4 Boundary conditions 

Create a new MIKE 11 Boundary Conditions file and insert boundaries as described 

below. 

 

Upstream boundary condition 

The inflow Hydrograph is supplied to you in the time series file: ‘Time 

series\Q_Sesupe_Kalvarija.dfs0’. Use the Time series item: ‘Polish Border’ at the 

upstream end of the Sesupe River. 
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Downstream boundary condition  

The downstream boundary condition at Sesupe 270500 m must be a Rating Curve (Q-h 

relation). 

 

Define the Q-h relation manually as follows: 

 

Water Level [m] Discharge [m] Water Level [m] Discharge [m] 

6.30     0.00 10.00 328.92 

6.51     0.02 10.05 336.92 

6.52     0.08 10.66 445.35 

6.55     0.27 11.28 568.81 

7.50   39.87 11.90 706.33 

8.12   89.78 12.52 857.47 

8.75 155.27 13.76 1198.37 

9.37 235.21 15.00 1587.84 

 

Note that if a cross-section is located at the location of the boundary condition, the Q-h 

relationship can be assessed through the Tools > Auto Calculation of Q/h Table… menu. 

Point source boundaries 

Additionally, you have to define a number of point sources.  

 

They represent the inflow from major tributaries in the Sesupe model area to the Main 

River – replacing physical definition of tributaries in this river modelling exercise. 

 

In the Time series file: ‘Time series\Tributary-Inflows.dfs0’ a number of time series have 

been defined with discharge from different tributaries.  

 

Define the following point sources using Time series ID’s from this time series file: 

 

Pont source location Time series item Information 

Sesupe,  ch.   55000 m Dovine_outflow_sim Simulated discharge in Dovine river 

Sesupe,  ch. 208900 m Jotija_outflow_sim Simulated discharge in Jojita river 

Sesupe,  ch.   25800 m Kirsna_outflow_sim Simulated discharge in Kirsna river 

Sesupe,  ch. 177900 m Nova_outflow_sim Simulated discharge in Nova river 

Sesupe,  ch. 192800 m Siesartis_outflow_sim Simulated discharge in Siesartis river 

Sesupe,  ch. 157500 m Sirvinta_outflow_sim Simulated discharge in Sirvinta river 

Sesupe,  ch. 117200 m Pilve_outflow_sim Simulated discharge in Pilve river 

Sesupe,  ch. 112900 m Rausve_outflow_sim Simulated discharge in Rausve river 

 

Save the boundary file in the same folder as the previous files (sim11, nwk11, xns11) and 

give it a meaningful name. Link it to the simulation file. 
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2.2.5 Hydrodynamic parameters 

Create a new Hydrodynamic Parameters file and adjust the following parameters in the 

parameter file: 

• Set a Global Manning number of M = 20 m
1/3

/s.  

• Set Delta (Default Values) to 0.6 

• Set Wave approximation to ‘High Order Fully Dynamic’ 

Save the HD Parameter file at the same location as the other files. 
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2.2.6 Simulation parameters – Run a simulation 

Open your simulation file and load the last file generated for the HD simulation under the 

Input page. 

 

 
 
1. Under the Simulation page, set the following parameters: 

Simulation period: 01/09/1997  -  01/07/1998  
(1 September 1997 to 1 July 1998) 

- Time step: 10 min. 

- Initial condition: Steady State 
2. Under the Results page, write a result file name and set the storing frequency to 36 

time steps (= every 6 hour). 
Save the simulation file  

3. From the Start page, run the simulation using MIKE 11 Classic engine and look at 
the results in MIKE View. 
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2.2.7 Analyse the base simulation results in MIKE View 

You can open MIKE View from Start > MIKE by DHI 20xx > MIKE View > MIKE View. 

MIKE View is a program used to load MIKE 11 results in *.res11 format. MIKE View can 

also be used to open *.res1d files if you have used the new MIKE 1D engine. 

 

Investigate the features of the MIKE View result presentation program. You can for 

example try the followings: 

 

Properties of Plan View page: 

• Right-click the mouse button and explore the different options. 

 

Make Time series Plots: 

• Look at different result items at different locations (WL, discharge) 

• Add multiple time series to one time series Plot 

• Show values (can be used to copy data into Excel) 

• Investigate the popup menu options by right-clicking the mouse button 
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Make Longitudinal plots: 

• Change plot settings  

• Investigate the popup menu options by right-clicking the mouse button  

• Add multiple result items to the same longitudinal plot 

• Multiple Areas plots  

Animate simulations: 

• Start animation with multiple plots open 

• Change animation settings 

Save Layouts (for re-using the same layout when opening new result file): 

• Window Layout 

• Complete Layout 

Calculate ‘Depth’ and ‘Flood’: 

• Use the internal tools in MIKE View to calculate the ‘Depth’ and ‘Flood’ results (if not 

already calculated). 

• What are Flood and Depth values as calculated by MIKE View? 

• Make a Longitudinal plot of Flood in Sesupe River. Any risk of flooding with the 

actual event? 

 
 

And just play around to become familiar and experienced in using MIKE View.  

 

You might even find the fish!  
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2.3 Additional Tasks for the HD Base Model Setup 

2.3.1 Add an additional river branch to base model by digitisation 

In this part of the exercise, you will digitise an additional branch in the network file and 

change the subsequent modelling files. 

 

 
 

River network 

Open the existing Network file (from the simulation file) and save it with another name like 

‘Sesupe_additional-branch.nwk11’. Remember to also rename the simulation file. 

 

Digitise the Jotija river branch (most Northern Tributary) on top of the background map. 

 

Topo ID = ‘Sesupe’ like for the first branch. Fix Upstream chainage = 0 m, and 

Downstream chainage = 47900 m. 
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Jotija is connected to Sesupe at ch. 208900 m (informed from surveyor). Manually 

connect the 2 rivers. Alternatively you can enter the connection in the Tabular View. 

 

After defining the connection it is clear from the connection line that the points and 

chainages of Sesupe River are not exactly correct as ch. 208900 m is not located at the 

point where Jotija enters Sesupe.  

 

Therefore, alter the chainage of the point at the outlet from Jotija in Sesupe River to have 

the exact chainage 208900 m. (How? – use the User Defined Point definition for the 

specific point.)  
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Cross sections 

Open the existing cross section file from the simulation file and rename it. 

 

Import the cross sections from the file; ‘Jotija-Sections.txt’  

 

Remember to calculate processed data for all cross- sections and change the parameters 

as done for the Sesupe cross sections earlier. 

 

Boundary condition 

The Inflow Boundary condition for the Jotija River is the same hydrograph that you used 

for the point sources for the Base-Model. 

 

Use the time series file; ‘Time series\Tributary-Inflows.dfs0’ and the Item; 

‘Jotija_outflow_sim’. 

 

NOTE: If you have used the boundary file from the base definition then you must delete 

the Point source definition for the Jotija inflow in order to have it replaced by the new 

‘Open’ boundary definition for the Jotija River (Important, to avoid a double inflow from 

this tributary). 
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Alternatively you can just change the boundary type from ‘point source’ to ‘open’ and 

change the chainage/river name. 

 

Remember to also rename the boundary file and link it to the simulation file. 

 

Simulation 

Before running the new simulation; change the result file name. 

 

Run the simulation using same simulation characteristics as in Base-simulation. 

 

Open results MIKE View and analyse them.  

 

 
 

Are the results as expected in Jotija River? And downstream of the connection point in 

Sesupe River? 
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2.3.2 Make yourself acquainted with the Network Editor, Graphical View features  

Change the display settings of the Graphical View to match your preference! 

 

Through ‘Settings’ ’Network’ you can change the appearance of all network items 

presented in the Graphical View. 

 

Change settings to match your preference (colours, thickness, and symbols for lines such 

as river branches, points for cross sections, Selected/highlighted Items etc.) 
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2.3.3 Automatic creation of boundary definitions 

The Network Editor has a useful tool for creating boundary locations at free ends in the 

river network to a boundary file.  

 

To try this feature, do the following: 

• Create a new (empty) boundary file 

• Save the empty file with a user-defined file name 

• Load the empty file in the Simulation Editor (Input) 

• In the Network Editor, Graphical View, now select ; ‘Network’  ‘Auto boundary 

(HD)….’ 

• Next, open the Boundary File and check the content of the file 

NOTE: A dummy-line is always created as line 1 with this operation. This line must simply 

be deleted manually, and thereafter the actual boundary conditions for the auto-generated 

locations can be inserted. You do not necessarily have to define boundary conditions for 

this file. The task was only to become acquainted with this useful feature. For this feature 

to work the network file and the boundary file must be linked through a simulation file and 

this simulation file must be open in MIKE Zero.  
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2.3.4 Create time series file with ‘tidal-like’ water level condition 

Although the time series files used in this exercise have been pre-defined and are ready 

to use, it is useful to know how to create a time series file from ‘scratch’. 

 

The task is to create a time series file with two items included: 

• Water level  

• Discharge 

From the MIKE Zero interface, create a new Time series file (dfs0). Select ‘Blank time 

series’.  

 

 
 

In the properties page define: 

• Two items as listed above 

• Equidistant time-axis 

• Time step of 1 day 

• Start-time: 1/1 1997, End-time: 1/7-1998 (547 days) 

The Water Level values should be set to 12.0 and 7.0 m on every second time step. The 

discharge (Inflow) should just be set to a constant value of 13 m
3
/s, cf. the figure below. 

 

 
 

Save the time series file and use the time series in a simulation with the varying Water 

Level as downstream boundary condition and the constant inflow for the Jotija Upstream 

boundary. 
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Remember to define a new result file name (boundary condition and simulation files too) 

for this simulation so that it can be compared to the previous simulation results in MIKE 

View. 

 

2.3.5 Additional output results 

Finally, you can save additional results from your MIKE 11 simulation. For that, open the 

HD11 file and go to the ‘Add. Output’ tab. 

• Select some of the Additional Output result items that you would like to analyse and 

run a simulation with some selections (both point results, and ‘Total’ results). 

• Load the Additional Results File created in MIKE View and analyse the results by 

plotting time series and longitudinal profiles of the additional and default results. 
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3 Stability Tests and Model Calibration 

3.1 Stability Tests 

For these simulations; use the Base setup as defined in the first task 

‘Sesupe_base.sim11’. 

 

Remember to change the result file name for each simulation in order to be able to 

compare results from different tasks. 

 

Perform the different tasks listed below one by one. 

 

3.1.1 Delta parameter change 

In the HD11 file, change Delta from 0.6 to 0.5 (save to another file name if necessary). 

 

Increase the time step to 30 minutes. Save every 3 time steps. 

 

If the HD11 file is saved under another file name, remember to select the right file on the 

Input page. 

 

Run the simulation and observe the simulation state – and investigate results. 

 

3.1.2 Delta parameter and wave approximation change 

Change the Delta back to 0.6 (as in the Base setup) but now change the Wave 

Approximation to ‘Fully Dynamic’. (Again, save to new file to differentiate simulations from 

each other). Also change the time step back to 10 min if the model is unstable. 

 

Run the simulation and observe the simulation state – and investigate results. Compare 

the results to the base scenario ones. 

 

Note that you can add 2 different result files in MIKE View to compare them. 

 

3.1.3 Time step change 

Use the HD11 file from the Base Setup Definition (High Order Fully Dynamic & Delta=0.6) 

 

Run the simulation with a time step of 30 minutes. 

 

State of simulation compared to simulation in previous tasks?  

 

Also compare simulation results to results produced for Base Setup (with time step = 10 

min). 

 

Increase the Delta from 0.6 to 0.9. 

 

Make a simulation and observe the results. Can the time step be increased even more? 

 

Set Delta back to 0.6 and the time step to 10 min. 
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3.2 Calibration Exercise 

The aim of this exercise is to adjust resistance values along the river channel and load 

and compare different simulation results in MIKE View. You will compare simulation 

results but also compare the results with an external (measured) time series file for 

calibration. 

For this exercise, we use the ‘Sesupe_Base.sim11’ setup. You can rename it to 

‘Sesupe_Base_Calibration.sim11’. 

 

3.2.1 Simulation#1 – Global resistance M=5 m1/3/s 

Open the HD11 Parameter file.  

 

Change the Global Resistance Value to M=5 m
1/3

/s. 

 

Open simulation file. Change result file name (to include ‘M=5’ or similar in the name). 

 

Run the new simulation. 

 

Open the result file in MIKE View.  

 

Compare the time series results at ‘Sesupe chainage 75000’ (WL and Q) to the measured 

time series.  

 

For this, use the ‘External Time series’ feature in MIKE View by right-clicking on the plot 

and choose ‘External TS’ and ‘Load DFS0’. The observed water levels are in the file 

named: ‘WL_Sesupe_Marijampole.dfs0’. 
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Do not close MIKE View after this first calibration as we will load the coming results in the 

same project for comparison. 
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3.2.2 Simulation #2 - Global resistance M=40 m1/3/s 

Open the HD Parameter file and change the Global Resistance Value to M=40 m
1/3

/s. 

 

Change the result file name in the simulation file (to include ‘M=40’ or similar). 

 

Run the new simulation.  

 

NOTE: The small bed resistance with M=40 causes the model to stop during the 

simulation in this base setup. To work around this, use a time step of 5 minutes for this 

simulation. 

 

Load the new results into MIKE View by adding them into the existing project/data in 

MIKE View from menu File > Add... 

 

Add the water level time series from this simulation to the same window with time series 

from the last simulation and observation time series. For that you can right-click on the 

existing plot and choose ‘Add TS…’. 

 

 
 

Note that you can also right-click on the plot and select ‘Options’ to edit the graph’s 

settings. 
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3.2.3 Simulation #3 – Local variations of resistance 

Open the HD Parameter file. Make some longitudinal, local variations of the bed 

resistance as follows: 

• Globally, M = 30 m
1/3

/s  

• Sesupe ch. 45000 m to ch. 92500 m : M = 25 m
1/3

/s  

• Sesupe ch. 92500 m to ch. 110000 m: Transition from M= 25 to M = 15 m
1/3

/s  

• Sesupe ch. 110000 m to ch. 150000 m: M = 15 m
1/3

/s   

• Sesupe ch. 150000 m to ch. 155000 m: Transition from M = 15 m
1/3

/s  to M = 20 

m
1/3

/s   

• Sesupe ch. 155000 m to ch. 200000 m: M = 20 m
1/3

/s   

 
 

Save the HD parameter file with another file name (include ‘M local’ or similar). 

 

Change the result file name in the simulation file and remember to load the renamed HD 

file. 

 

In the HD parameter file, select the Additional Output item named ‘Resistance’ in order to 

verify that the model is actually using the resistance number that you have defined (locally 

varying). 

 

Run the new simulation. 
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Open the Additional Results file in MIKE View and make a longitudinal profile plot of the 

Resistance Numbers to ensure that the model is using the resistance numbers as you 

think it is (the Global/Local variation as you have specified). 

 

 
 

Load the new Simulation Results into MIKE View by Adding the new results into the 

existing project/data in MIKE View where you have already loaded the results for 

calibration 1 and 2. 

 

Add time series from this simulation to the window with time series from last simulation 

and observation time series. 

 

Finally, load the Base Simulation results (using M=20 m
1/3

/s) into MIKE View and 

compare the time series of WL to the other simulation results and the observation. 

 

 
 

Which simulation is apparently the best in terms of calibration?  
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Consider / discuss what could be the reasons for the discrepancy between measurements 

and simulation results: 

• Water balance - why?  

• Resistance numbers?  

• Missing input components in model?  

• Other reasons?  
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4 Adding Structures to the HD Model 

4.1 Overflow Weirs 

In this exercise, you will add hydraulic structures to the base simulation. You can start by 

renaming the base simulation and network files so that they include the name ‘structure’ 

or ‘weir’. You can also create a new folder for the new structure files under the Model 

folder so that it’s easier to work with all the files. 

 

4.1.1 Overflow structure in the Sesupe River, chainage 157200 m 

Open the network file and go to the tabular view. 

 

Insert a broad crested weir at this location: 

 

Sesupe - Chainage 157200 m, Geometry: 

Level (m) Width (m) 

26.90 0 

27.00 15 

28.00 20 

31.00 40 

 

Remember to calculate the structure Q-h relations (by pressing the ‘Calculate Q-h 

relations’ button) for each structure. 

 

You can also plot the structure to compare it to the upstream and downstream cross 

sections. 

 

It is also a good idea to give the structure an ID so that you can check additional results 

for each individual structure. 
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4.1.2 Simplified descriptions for two hydropower plants; Marijampole HE and Antanavo 
HE  

In the original river model these are defined as controllable structures with operational 

underflow gates to illustrate the turbines etc. 

 

In this exercise we include two simple overflow weirs to represent the reservoirs at the 

two locations.  

 

Insert the following two weirs in the network file: 

 

Sesupe - Chainage 93500 m (Antanavo HE), Geometry: 

Level (m) Width (m) 

49.4 0 

49.5 40 

52.0 50 

 

Sesupe - Chainage 69100 m (Marijampole HE), Geometry: 

Level (m) Width (m) 

65.0 0 

65.1 20 

71.0 25 

 

Remember to calculate the structure Q-h relations (by pressing the ‘Calculate Q-h 

relations’ button) for each structure and to give the structures an ID. 

 

Save the network file using a new name (something like ‘Sesupe_ Weirs.Nwk11’) if you 

haven’t already renamed the file before starting this new exercise. 

 

Specify a different result file name and run the simulation including the three structures 

defined above. All other data should be kept the same. 

 

In the HD Parameter file, activate the Additional Output results Item; ‘Velocity, Structures’ 

which allow you to save results at structures (structure Q, Area and Velocity). 

 

4.1.3 View the results in MIKE View 

Load the standard result file and visually compare the results to previous simulations (for 

example by plotting a longitudinal profile).  

 

Are there water level differences as it could be expected with the introduction of weirs in 

the model? 

 

Open the Additional output result file. Plot time series of structure discharge. 
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NOTE: Structures are ‘Results in a single point’ and hence, structure time series cannot 

be selected using the normal tool as for calculation points. Instead, you should use the 

option ‘Plot TS of System Data’. 

 

 
 

 
 

 

4.2 Composite Bridge Definition 

In this exercise, you will add a composite bridge structure to the base simulation as in the 

previous exercise. You can start by renaming the base simulation and network files so 

that they include the name ‘bridge’ or similar. 

 

A bridge is located at ch. 157200 m. 

 

The bridge (rather artificially shaped and very incorrectly drawn) is a 10-metre long and 

wide composite bridge as illustrated in the figure below. 

 

 
 

Define the below specified bridge geometry as a combined / composite structure in MIKE 

11 using a combination of weir and culverts. 

 

• Section A is a circular pipe culvert of diameter 1 meter (Invert Level = 27.5 m) 

• Section B is a rectangle culvert of 8 m width and 2 m height (Invert Level = 27 m) 

• Section C is a Circular pipe culvert of diameter 1 m (Invert Level = 28 m) 

A 
B 

C 

D 
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• D illustrates the potential overtopping of water over the road on top of the bridge 

(weir). The overtopping bridge deck is to be defined as an overflow weir with an 

overtopping level at level 30 m – and an overtopping width of 55 m. 

Also use default loss coefficient values for all types of structures. 

 

Remember to calculate the Q-h relations for all the structures and to plot the structures to 

make sure the geometry is correct based on the upstream and downstream cross 

sections. 
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Make sure that the structure results are also saved (as HD Additional output file). 

 

Run the simulation and compare the results of water levels upstream and downstream of 

the structures with the previous simulation results. 

 

Investigate structure discharge for the different bridge openings (from HD Additional 

output). 
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4.3 Operational Structures 

Two Hydro Electrical (HE) Power Plant structures are located on the Sesupe River. 

Turbines and operational gates in these two Power plants shall be implemented in the 

Sesupe MIKE 11 model following the below defined control strategies. 

 

Use the setup created for the Sesupe Base including Weirs as generated in a previous 

task. 

 

Before starting, rename all the files and the result file. 

 

4.3.1 Marijambole HE power plant 

Let us first implement a control structure definition for the Marijambole HE structure which 

is located in Sesupe, ch. 69100 m. 

 

The Marijambole HE plant in this exercise is implemented as a combination of a single 

turbine structure together with an overflow crest structure. 

 

Task #1: Adjust the overflow weir at the Marijambole location 

We will now change the definition for the overflow weir at this location so that it will be an 

overflow structure for the overtopping of the HE structure. 

 

Open the network file with 3 weirs included and alter the geometry for the weir at the 

Marijambole HE location ch. 69100 m.  

 

To make it easier to quickly analyse results from individual structures in the model, you 

should specify a Structure ID in case it has not already been done. 

 

Change the weir geometry to the following: 

 

Datum = 72.08 m  

Level (m) Width (m) 

0.0 m 10.0 m 

1.0 m 310.0 m 

 

Remember to recalculate the Q-h relation for the new defined structure geometry. 

 

Task #2: Define the turbine as a control structure 

Add a new Control Structure and define the location of the structure as the location of the 

Marijambole HE power plant. 

 

Turbines in a MIKE 11 model are practically always included and controlled to allow a 

certain discharge through the turbine and therefore, a turbine in MIKE 11 will normally be 

defined as a controllable structure of the structure type: ‘Discharge’. 
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This means that the control definitions setup in the model will determine the actual 

discharge through the turbine structure instead of defining an actual gate level which is 

the other type of applying the control structure module. 

 

Therefore, the overall structure characteristics are: 

• Type: Discharge 

• Number of turbines = 1. 

• Max speed = 0.1 (m
3
/s/s)   ( Max speed = rate of change in turbine discharge = how 

fast can the turbine respond and change from one discharge to another) 

The Turbine is controlled by a number of control strategies, which must be implemented 

in MIKE 11. 

 

In this case, the turbine control strategies are the following: 

 

Control Definition for Turbine Structure in Marijambole HE Power Plant Dam 

Control 

Definition 

(prioritized) 

Condition Turbine Operation 

1 IF  

Water Level in h-point upstream of 

Marijambole Dam is < 69.65 m. 

THEN 

QTurbine = 1.42 m
3
/s (constant) 

2 ELSE IF 

Water level in h-point upstream of Marijambole 

Dam is > 70.50 m 

THEN 

QTurbine = Tabular function of Head difference 

across the dam (dH). 

 

dH = WLch.69200 – WLch.69000  

 

dH QTurbine 

 0.0 m    0.0 m
3
/s 

9.5 m 10.0 m
3
/s 

20.0 m 10.0 m
3
/s 

 

3 ELSE IF 

QTurbine < 1.42 m
3
/s  

THEN 

QTurbine = 1.42 m
3
/s (constant)

 

4 ELSE 

(do this if none of the above conditions are 

true/fulfilled) 

THEN 

QTurbine = QTurbine  (unchanged flow) 

 

A bit of assistance to get started: 

• Each individual control definition for a structure must have a separate line in the table 

for ‘Control Definitions’ on the Control Structures page. 

That is, we need 4 lines in this table to create the above specified control (like 

always, use the <TAB> to create additional lines in the table). 

• The ‘Control Definitions’ table is primarily an overview table which presents the 

different control definitions made for the particular structure.  

Definitions of all the actual Conditions and Structure operation strategies are made in 

the separate dialog showed when pressing the ‘Details…’ button.  

• The Details dialog has the following content:  
a. The Logical Operands page is where all the conditions are defined (e.g. Water 

level in chainage 69000  > 69.65 m) 



Adding Structures to the HD Model  

 43 

b. The Control and Target point page is where we define which parameter is used 
to actually control the operation of the turbine 

c. The Control Strategy page is where possible tabulated relations between the 
control point variable and the control structure Target Value (=Turbine discharge 
or Gate Levels) are defined 

d. The Iteration/PID page includes the possibility to define iterative controls of the 
control structure 

 

Hence, to define the second Control Definition in the above table you have to proceed as 

follows from the Logical Operands page: 

• Select ‘LO Type’ to be ‘H’   (alternatively the option ‘Hups’ can be used!) 

• Specify definitions for the location of ‘LO1’ (Logical Operand first location). Branch 

Name LO1 = ‘Sesupe’,  

Chainage LO1 = 69000 m (just upstream of the dam) 

• Choose the correct ‘Sign’ ( ‘>’ ) 

• Use TS-Value = no  (TS stands for Time series file) 

• Value = 69.65 m 

To define a constant flow for a structure there are two options - a very simple and easy 

one and a slightly more complex one:  

• The easy method:: 

The easy method is simply to close the Details dialog and in the Control Definitions 

Table choose the Calculation Mode option; ‘Set Equal To’ and then specify the 

constant value (=1.42) in the value column of this table. 

• The slightly more complicated method: 

Select the calculation mode option ‘Tabulated’: 

- click Details… to enter the dialog and specify in the Control and Target point 

page that the control point should be the H in upstream water level point 

(Sesupe, ch. 69000m) 

- In the Control Strategy page we define a table like specified below: 

 

Control Point Value Target Point Value 

-1000 m 1.42 m
3
/s 

 1000 m 1.42 m
3
/s 

 

This table simply says that for any actual water level at the upstream side of the 

dam during the simulation between -1000 m and 1000 m then we will set the 

turbine discharge equal 1.42 m
3
/s (which is the same as saying that the turbine 

flow will always be constant as water level variations will not exceed -1000 to 

1000 m! 

 

Thereby, this control definition is ready.  

 

Now you must define the remaining three control definitions yourself!  

• Run the simulation using the same simulation definitions as in previous weir 

simulations (you can maybe save results more frequently). 

• Open result files (both standard result file and Additional HD result file) in MIKE View 

and look at the results. 

• Also, check the result item which shows the actual control definition which has been 

used during the simulation at each time step. 
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4.3.2 Antanovo HE power plant 

Secondly, we will also implement the more complicated control definition for the other HE 

Power plant named ‘Antanavo’. This structure is located in Sesupe, ch. 93500 m. 

 

The Antanavo HE plant in this exercise is implemented as a combination of a single 

turbine structure, 4 underflow gates where 1 works individually and the 3 other gates 

operate in parallel. Additionally, an overflow crest structure must be defined. 

 

Task #1: Adjust the overflow weir at the Antanavo HE dam location 

Change the present definition for the overflow weir at this location such that it will be an 

overflow structure for the overtopping of the HE structure. 

 

Before adding the new structure, rename the network, simulation and results files. Use 

the setup generated previously with the overflow structures and the Marijampole turbine. 

 

Open the network file with weirs and the Marijambole control structure included and alter 

the geometry for the weir at the Antanavo HE location.  

 

Remember to specify a Structure ID also here in case it has not already been done! 

 

Change the weir geometry to the following: 

 

Datum = 52.50 m 

Level Width 

0.0 m 10.0 m 

1.0 m 255.0 m 

 

Again, remember to recalculate the Q-h relation for the new defined structure geometry. 

 

Task #2: Define the controllable structures in the dam 

Task #2-1: The turbine structure 

Add a new Control Structure to the existing network file including the Marijambole turbine 

operational structure and define the location of the structure to the location of the 

Antanavo HE power plant.  

 

There is only 1 turbine present in the Antanavo Dam. As the turbine is included to set a 

turbine-flow in the model; the structure is a Discharge Type. The max speed of operation 

can be defined as 0.1 m
3
/s/s. 

 

This turbine is also controlled by a number of control strategies to be implemented in 

MIKE 11. 
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The turbine control strategies are the following: 

 

Control Definition for Turbine Structure in Antanavo HE Power Plant Dam 

Control 

Definition 

(prioritized) 

Condition Turbine Operation 

1 IF  

Water Level in h-point upstream of Antanavo 

Dam is < 51.00 m. 

THEN 

QTurbine = 1.42 m
3
/s (constant) for all levels 

upstream of Dam below 51 m. 

2 ELSE IF 

Water level in h-point upstream of Antanavo 

Dam is < 51.30 m 

THEN 

QTurbine = 1.62 m
3
/s (constant) for all levels 

upstream of Dam above 51 m. 

 

3 ELSE IF 

Water level in h-point upstream of Antanavo 

Dam is > 51.30 m  

 

THEN 

QTurbine = Tabular function of Head difference 

across the dam (dH). 

 

dH = WLch.93150 – WLch93550  

 

dH QTurbine 

 0.0 m    0.0 m
3
/s 

 1.5 m    0.0 m
3
/s 

5.3 m 11.0 m
3
/s 

10.0 m 11.0 m
3
/s 

 

4 ELSE IF 

QTurbine < 1.62 m
3
/s  

THEN 

QTurbine = 1.62 m
3
/s (constant) for all levels 

upstream of Dam.
 

5 ELSE 

(do this if none of the above conditions are 

true/fulfilled) 

THEN 

QTurbine = QTurbine  (unchanged flow) 

 
When you have set up the turbine for Antanavo HE, save the files and run the simulation. 

 

Analyse the results from the simulation (turbine flow, control definitions used, crest 

overflow?) 

 

Task #2-2: First (simple) implementation of the 4 operational gates in Antanavo 
Dam 

Add another Control Structure to the network file at the location of Antanavo HE Dam. 

Before starting, you can rename the simulation, network and result files to differentiate 

them from previous tasks. 

 

This structure will be a first example of implementing an operational gate. 

 

In this task we will implement all the 4 gates in the dam in one common definition – under 

the assumption that they are all ‘locked’ together and operate simultaneously. 
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The 4 gates are defined as follows (identical): 

• Underflow Gate 

• Width = 5 m 

• Sill level = 49 m 

• Initial value = 49 m (= closed initially!) 

• Max operational speed = 1 m/s (very fast!! But, defined to get immediate response 

from control definitions) 

We would like to implement a simple strategy in order to try to keep the water level in the 

reservoir upstream of the dam within a requested/pre-defined range.  

 

Desired reservoir level in this example ranges between level 50.6 m and 50.8 m.  

 

The control strategy for the 4 gates structure is described in the table below: 

 

Control Definition for the 4 Gates Underflow Structure in Antanavo HE Power Plant Dam 

Control 

Definition 

(prioritized) 

Condition 4-Gates Operation 

1 IF  

Water Level in h-point upstream of Antanavo 

Dam is > 50.80 m. 

THEN 

Raise Gate Levels with 0.1 m 

2 ELSE IF 

Water level in h-point upstream of Antanavo 

Dam is < 50.60 m 

THEN 

Lower Gate Levels with 0.1 m 

 

3 ELSE 

(do this if none of the above conditions are 

true/fulfilled) 

THEN 

Keep present gate position (unchanged) 

 

Run the simulation and analyse the results: 

• Is it possible to maintain the reservoir levels within the requested range? 

• Look at discharges through the different structures (turbine, overflow, gates). 

• Look at the gate level for the 4-gate structure 

Task #2-3: Multi gate control definitions in Antanavo Dam 

We will now implement a more complex (but probably more realistic) control definition for 

the gates in Antanavo Dam. 

 

Instead of the implementation made in the previous task we will now operate the 4 gates 

differently such as 1 gate is operated individually and the last 3 gates are operated 

together. 

 

Therefore, we will need to: 

• Adjust the control structure we made in the last task to be a 1-gate structure, only  

• Make an additional control structure definition in the network file we just created in 

the previous task  

That is, we will now have three control structure definitions at Antanavo Dam (Sesupe, ch. 

93500 m): 

• one for the turbine  

• one for the single-gate  

• one for the three-gate control 
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We want to implement control strategies for the gates such that they are operated 

differently (the 1-gate and 3-gate structure) – but still to some extent depending on each 

other.  

 

In the definitions below we will open the 1-gate structure up to a specified maximum (level 

50 m) and then open the 3-gate structure if necessary. Also, when closing structures, we 

will make sure to close the 3-gate structure completely before we start to operate on the 

1-gate structure. 

 

The control definitions for operational structures are listed in the following tables. 
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Control Definition for the Single Underflow Gate in Antanavo HE Power Plant Dam 

Control 

Definition 

(prioritized) 

Condition Gate Operation 

1 IF  

Water Level in h-point upstream of Antanavo 

Dam is ≥ 51.00 m 

AND 

GateLevel1gate <=  50 m 

AND 

GL3gates is closed   (gate level  =< 49 m) 

THEN 

Raise Gate Level with 0.2 m 

2 ELSE IF 

Water Level in h-point upstream of Antanavo 

Dam is ≤ 50.25 m 

AND 

GL1gate  NOT closed (=> GL > 49 m) 

AND 

 GL3gates  Closed 

THEN 

Lower Gate Level with 0,1 m 

 

3 ELSE 

(do this if none of the above conditions are 

true/fulfilled) 

THEN 

Keep present gate position (unchanged) 

 

Control Definition for the Three Underflow Gates in Antanavo HE Power Plant Dam 

Control 

Definition 

(prioritized) 

Condition Gate Operation 

1 IF  

Water Level in h-point upstream of Antanavo 

Dam is ≥ 51.25 m 

AND 

GL1gate =  50 m  (fully open) 

AND 

GL3gates <= 50 m  

THEN 

Raise Gate Level with 0.2 m 

2 ELSE IF 

Water Level in h-point upstream of Antanavo 

Dam is ≤ 50.50 m 

AND 

GL3gates  NOT closed (GL > 49 m) 

THEN 

Lower Gate Level with 0,1 m 

 

3 ELSE 

(do this if none of the above conditions are 

true/fulfilled) 

THEN 

Keep present gate position (unchanged) 

 

Save the network file with a different name. Also, save the simulation file and the result 

file, and run the simulation. 

 

Do the gates operate as intended? Analyse all the results. 
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4.4 Dam Break Modelling 

4.4.1 Single dam break structure in model 

In this exercise you have the opportunity of inserting and analysing a dam break structure. 

 

We will simulate what happens if a dam is constructed in the Sesupe River – and what 

consequences it might have if it breaks due to extreme water level in the reservoir 

upstream of the dam. 

 

Use the Sesupe_Base setup. Before starting with this exercise, rename all the files from 

the Sesupe_Base setup as well as the results. If necessary create a new folder to save 

the new files under the project. 

 

The dam structure is located at chainage 69100 m 

 

Task #1: Environmental flow downstream of dam 

In order to secure a minimum flow (environmental) downstream of the dam structure, 

initially insert a circular culvert at the bottom of the reservoir structure. 

• Use a circular culvert of diameter 0.25 m.  

• Upstream Invert level = 63.6 m and  

• Downstream Invert level = 63 m and  

• Length = 10 m. 

Remember to calculate the Q-h relation for the culvert. 

 

Task #2: Defining a narrow spill-channel overflow structure  

A spill-channel overflow structure is assumed to be located at the dam site: 

• Define the spill channel structure as a broad crested weir at the dam location. 

• Geometry: 

Level [m] Width [m] 

64.9 0.0 

65.0 1.0 

68.0 1.0 

71.0 2.0 

72.0 5.0 

74.0 20.0 

 
(Remember to calculate Q-h relation). 

 

Run the simulation and reserve the results that we will use as hotstart file for the dam 

break simulation. 

 

Task #3: Defining the dam break structure 

Edit the network file and specify a dam break structure at the same location with the 

following specifications: 
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• Crest level = 72 m 

• Crest length = 200 m 

• Failure mode : Reservoir Water Level 

• Reservoir Water Level = 71.5 m 

• Failure Mode = Time Dependent. 

The dam break is time-controlled and a time series file must be created with specifications 

for the breach geometry.  

 

Make a new time series file with the following content (3 items must be defined in the file): 

 

Time 

[sec] 

Breach Level 

[m] 

Breach Width 

[m] 

Breach Slope 

[] 

0 70.8 10 2 

14400 65 200 2 

1E+008 65 200 2 

 

 

NOTE: Time axis type in time series file (dfs0) MUST be ‘Relative’ for a dam break 

specification. 

 

 
 

Add the time series as a boundary condition for the dam structure in the boundary file. 
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Task #4: Simulations 

1. Use the result file from the initial setup you have prepared in the previous step as 

Hotstart file (Initial conditions) for this simulation. 

- Hotstart time : 1/2-1998 

- Reduce simulation time:  1/2-1998 – 1/4-1998 

- Time step = 5 min. 

- Save every third time step (change saving frequency) and modify the result file 

name.  
2. It is also a good idea to save additional results at the structures in order to be able to 

check the details of the dam break. 

3. Run the simulation and investigate the results from dam break simulation in MIKE 

View.  

- Does the dam break at all??  

Well, no, because the spill channel structure is able to convey the water for 

‘normal flow conditions!! 

4. So - we will introduce a ‘Critical Event’ in our model setup. In the time series file with 

Inflow from Tributaries (Tributary-Inflows.dfs0) we have made an additional time 

series for the Inflow from Dovine River, in which the discharge is simply increased by 

a factor of 3.  

- Open the Boundary file and select this increased time series as inflow from 

Dovine River instead (that is, at the point source location; Sesupe, 55000m, we 

must choose the time series named ‘Dovine_Outflow_*3’ instead of the original 

time series used up to now). 

- Save the Boundary file (preferably in another name) and make sure that you 

have this boundary file selected in the simulation file. 
5. Change the name of the simulation file and the name of the result file too (in order to 

compare results from the previous simulation to the one you are making now). 
6. Run the simulation again. 

This time the dam should actually break down! 
  



 MIKE 11 HD 

52 River Model Setup and Modules Application Manual - © DHI 

7. Analyse the results in MIKE View.  

- In MIKE View, try to calculate the ‘Flood’ results and plot a longitudinal profile 

with water level and add ‘Flood’ results to the profile through the options dialog. 

This is a quick option to obtain an overview of where flooding occurs (water 

levels above one or both embankment markers in MIKE 11 cross sections). 

- Also load the additional results for structures and compare the flow through the 

breach, the crest, etc. 

- Also note the Ascii file; ‘…DAMBRK1.TXT’ produced from the simulation and 

saved in the simulation folder. It contains information on the breach evolution. 

 

If time permits: Make additional simulations with different breach definitions in the time 

series file.  

 

4.4.2 Additional erosion based breach failure dam break 

Add another dam break structure in to the model. This time we will insert an earth dam at 

the location of the Marijampole powerplant. 

 

Add a new dam break structure at chainage 93500 m as described in the next steps. 

 

Before modifying the model setup, rename all the input files and result file. 

 

Task #1:  Environmental flow downstream of dam 

In order to secure a minimum flow (environmental flow) downstream of the dam structure, 

insert initially a circular culvert at the bottom of the reservoir structure: 

• Use a circular culvert of diameter 0.25 m.  

• Upstream invert level = 50.0 m and downstream invert level = 49.5 m and length = 

10 m. 

 (Remember to calculate Q-h relations for the culvert). 

 

Task #2: Defining a narrow spill-channel overflow structure 

A spill channel overflow structure is assumed to be located at the dam site. 

• Define the spill channel structure as a broad crested weir at the dam location. 

• Geometry: 

Level [m] Width [m] 

49.4 0.0 

49.5 8.0 

52.0 8.0 

53.0 10.0 

54.0 20.0 

 

Remember to calculate Q-h relations. 

 

Run the simulation for the full period (1997-1998) to prepare a hotstart file for the next 

simulation with the dam break. 
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Task #3: Defining the dam break structure 

The dam break structure is defined with the following parameters: 

• Crest level at 51.8 m 

• Crest length 200 m 

• Failure starts at a reservoir level of 51.5 m. 

• Failure mode: Erosion based. 

Erosion dam break definition: 

• Dam geometry: Upstream and downstream slope = 2 

• Top width = 10 m 
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Material properties: 

• Diameter : 1 cm 

• Gravity  :2.65 

• Porosity : 0.4 

• Critical shear stress : 0.03 

• Side erosion index = 1 

Limit of breach geometry: 

• Bottom level 49.5 m 

• Bottom width 40 m 

• Slope 2 

Initial breach failure: 

• Initial level = 51.2 

• Initial width = 0.5 m 

Run the simulation with both dam break structures. 

 

Investigate the results from the dam break simulation. 

 

Additional Task #4: Investigate dam breach of earth dam without upstream dam 
failure 

In order to evaluate the breach of the earth dam at ch. 93500 m, de-activate the breach of 

the Antanavo Dam at ch. 69100 m. 

 

This is easily done by specifying the reservoir level at which this dam will start failing to a 

high number (e.g. 100 m). Thereby, the water flowing through the dam site is only that of 

the minimum flow culvert and the spill channel overflow weir. 

 

If time permits, you can save the network file, the simulation file and the result file with 

different names and re-run the previous simulation with this revised network file. 

 

NOTE: The ‘SimulationName’_DambrkX.txt file produced during dam break simulation will 

always use this default name and consequently, it will be overwritten every time a new 

dam break simulation is started with the same simulation name. 

 

Therefore, if you want to save it for comparing with other simulations then it is required 

that you manually rename the file after a simulation or rename your simulation file.  
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4.4.3 Erosion based dam break – Erosion based pipe failure 

We will now try to make a dam breach in the earth dam by use of an initial Piping Failure. 

 

Open the network file from the previous task and adjust the definition for the Marijampole 

Dam (ch. 93500 m) as follows. 

 

Under ‘Erosion Parameters…’ specify: 

• Initial Failure : Piping Failure 

• Starting level = 50.5 m 

• Initial diameter = 0.2 m 

• Roughness = 0.01 

• Collapse ration = 1 

• Volume loss ratio = 0 

• Calibration coefficient = 1. 

Save the network file with a new name and use this to make a new simulation. 

 

Investigate the results in MIKE View and check in particular the DambrkX.txt file from this 

dam. Note the switch from pipe flow to open flow during the dam break. 

 

If time permits, you can make some additional simulations using different values for the 

breach parameters to become more acquainted to the impact of these parameters to the 

results. 

 

4.4.4 Reservoir definition - Calibration of reservoir level-volume curve 

Modelling of reservoirs includes several considerations, e.g. what type of structures to use 

and how to define them as correctly as possible in the model. However, another very 

important task when modelling reservoirs is to make sure that the Level-Volume relation 

in the model is consistent with the relation for the natural reservoir. If the Level-Volume 

relation in the model is not correct then reservoir levels following specific inflow events to 

the reservoir will not be correct. 

 

The Reservoir upstream of Antanovo Dam is presently physically defined by five model 

calculation points. These are the h-points at chainages 69000 m, 65150 m, 62500 m, 

57250 m and 52000 m. 
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From a ‘survey’ was constructed a Level-Volume curve for the entire reservoir (defined in 

the model by the four calculation points) as presented below: 

 

Level [m] Volume [m
3
] 

64.0 0.3*10
6 

65.0 0.5*10
6
 

66.0 0.9*10
6
 

67.0 1.6*10
6
 

68.0 2.5*10
6
 

69.0 3.8*10
6
 

70.0 5.2*10
6
 

71.0 6.8*10
6
 

72.0 9.5*10
6
 

 

Make a calibration of this reservoir such that the level-volume relation of the numerical 

model is (approximately!) in agreement with the above present ‘surveyed’ level-volume 

curve.  

 

The most commonly applied approach for calibrating / adjusting the reservoir level-volume 

relations in simulations is to adjust the additional flooded area data in the processed cross 

section data. 

 

HINTS: 

Extract volumes in calculation-points by selecting Additional Output variable in HD11 file. 

 

Change the dam structure definition such that no water will leave the reservoir until it 

overtops at level 72 m (top level of ‘surveyed’ level-volume relation). That means remove 

the spillway and pipe for environmental flow. You should also raise the reservoir level 

initiating the break. 

 

Remove all point sources in model for this calibration task. Use a constant inflow, Q= 5 

m
3
/s as upstream inflow boundary in order to more easily calculate the inflow volume of 

water. 

 

Initial conditions for the reservoir should be that it is (practically) empty (use parameter 

file, Initial depth = 0.01 m). 

 

For this simulation it is required to use a smaller time step to avoid instabilities at the start 

of the simulation. Use a time step of 2 minutes. Save all the time steps of the simulation. 

Change the simulation period to: 1/9-1997 – 1/11-1997. 

 

You could also recalculate the levels in the processed data table to have smoother 

results. 
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5 Flood Management 

The purpose of this task is to try to define a flood management measure in the present 

model to prevent significant flooding at some local areas due to a heavy (artificial) inflow 

to the river system. 

 

We will use the Sesupe_Base setup as defined at the beginning of this tutorial.  

 

Before you start this exercise, remember to rename all the files and save them in a new 

folder for Flood Management. 

 

5.1 Introduce a “Flooding Disaster Event” into the Model 

We have to introduce additional inflow to the river model in order to ‘force’ a flooding 

situation along the river as the events applied up to now are not so critical and they do not 

introduce any flooding. Therefore, we will add additional water through the boundary 

definitions. 

 

To increase the inflow to the river for this exercise, open the boundary file and change the 

inflow conditions as defined in the list of actions below: 

 
1. Open the time series file named ‘Tributary-Inflows.dfs0’ and add an additional time 

series item (through ‘Edit -> Properties’): 
a. Name the new item; ‘Sirvinta_Outflow*3’ and choose the Item-Type = Discharge 
b. Press OK to return to the Graphical and Table view and now activate the 

Calculator tool. We want to include values in this new item as a multiple of 3 
times the existing values for ‘Sirvinta_Outflow’ 

c. When the definition of the new time series item is completed (with values 3 
times the Sirvinta outflow item) then save the dfs0 file and close the file 

2. In the boundary file make the following changes: 
d. At Sesupe, ch. 55,000 m: Change the time series item used for this inflow. Use 

the item named ‘Dovine_Outflow_*3’ instead  (from the same dfs0 file!) 
e. Create a new boundary definition as a point source 
f. Location:  Sesupe, ch. 157,500 m (this means that we now have two boundaries 

at that location!) 
g. Select the time series item that you just created before. Use the time series item 

named ‘Sirvinta_Outflow*3’ 
h. Create a new distributed source with: constant inflow of 40 m

3
/s, between 

Sesupe ch. 100,000 m and 140,000 m 
i. Save the boundary file 

 

Run the simulation again with the increased input to the river. Make sure you have 

renamed all the files as well as the results before launching the simulation. 

 

Open and analyse the results of this simulation in MIKE View. Check the Flood result item 

for an easy detection of whether flooding occurs in the simulation – and where. 
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5.2 Introducing a Flood Plain Branch 

As an attempt to solve part of the flooding introduced with the severe inflow to the model 

we will activate an area along part of the Sesupe River as a flood storage area. 

 

The flood storage area will be included as indicated on the figure below. 

 

The additional model-components will be defined by a flood storage branch and two ‘link 

channels’ at each end connecting the main river to the flood storage branch. 

 

Use the setup created in the previous exercise and rename the simulation and network 

files as well as the result file. 

 

Open the network file and make the following changes: 

 
1. Digitise a new river branch (the Floodplain branch) along the Sesupe River (between 

chainages 105500 m and 116500 m): 
a. Name the new branch FP1 (Topo ID could be ‘2011’) 
b. Make it 7000 m long (use user defined chainages) 
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2. Digitise two new, short river branches at both ends of the floodplain branch (length = 
50 m). 

 

 
 

3. Branch type of these branches must be ‘link channel.’ Rename the 2 channels to 
‘Upstream_Link’ and ‘Downtream_Link’. 

4. Connect the floodplain branch to the link channels up- and downstream. 
5. Connect the two link channels to Sesupe River at chainages 105500 m (upstream 

link) and 116500 m (downstream link). 
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The link channels parameter definitions should be as shown below (click the ‘Edit Link 

Channel Parameters…’ button in the tabular view): 

 

Upstream Link: 

• Bed level upstream: 41 m 

• Bed level downstream: 37 m 

• M = 25 m
1/3

/s 

• Geometry: 

Level [m] Width [m] 

0.00       0 

0.25 2000 

6.00 2000 

 

Remember to calculate the Q-h relation for the link. 

 

Downstream Link: 

• Bed level upstream: 39 m 

• Bed level downstream: 37 m 

• M = 25 m
1/3

/s 

• Geometry: 

Level [m] Width [m] 

0.00       0 

0.25 2000 

6.00 2000 

 

Remember to calculate Q-h relation for the link. 
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6. Save the network file in another name. 
7. The next task is to generate the cross sections for the flood plain branch: 

a. Open the cross section file and add two new cross sections for the flood plain 
branch you just created; one cross section at each end of the branch 

b. The River name and the Topo ID for the cross sections must be identical to what 
was defined in the network file previously 

c. Insert cross section geometry such that the upstream section has a bottom level 
of 38 m and downstream section a bottom level of 37 m  

d. Cross sections are both 500 m wide and have a rectangular shape 
8. Save the cross section file. 
9. Instead of Steady State initial conditions, use Parameter file with Initial Depth = 0.5 m 

globally and local depth in the flood plain branch of 0 m (‘empty branch initially). This 
is set in the HD11 file. Save the HD11 file. 

10. The time step must be reduced slightly (to 5 minutes) in order to overcome initial 
‘noise’ in the simulation due to the relatively ‘coarse’ initial conditions. 

11. Run the simulation and evaluate if this flood plain branch has improved the flooding 
conditions!? 

 

If time permits, try to adjust the flood storage volume to improve the control of the flood 

conditions locally. 
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6 MIKE 11 Mapping 

The purpose of the following tasks is to get acquainted with the mapping feature of MIKE 

11 – found in the HD Parameter file. This feature allows you to generate 2D map outputs 

from a 1D simulation. 

 

6.1 Generate 2D Files from a MIKE 11 Simulation 

1. Open one of the simulations created previously. You can start with the Sesupe_Base 
setup for example. Before you start editing the files, rename them. 

2. Open the HD Parameter File and go to the ‘Maps’ page. 

- Activate the mapping function by enabling ‘Generate Maps’ tick box. 

3. Define the parameters for the 2D grid file to be produced as an output from the 

simulation. 

One or more maps can be produced – if they are not too big! Too big means that memory 

consumption must not exceed what is possible to allocate within Windows. 

 

As an initial example you could try to insert the below listed definitions to see an example 

of the map produced from this feature. 

• Origin coordinates (X,Y): (450500, 6062000) 

• Rotation : 0 (radians) 

• Grid cell size (rectangular grids): 4 m 

• Number of grid cells in j-direction (along X-axis): 1100 

• Number of grid cells in k-direction (along Y-axis): 600 

• File name: You define a file name. It MUST have the extension ‘.dfs2’ 

• For this initial attempt select the Maximum results of Water Depth throughout the 

simulation period 
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4. Save the HD11 file and select this in the Simulation file if not done already. 
5. Run the simulation. 
6. When the simulation is complete, a dfs2 file should have been produced with your 

choice of result output included. 

 

Grid files (dfs2 files) can be opened and investigated in the so-called ‘Grid Editor’ of MIKE 

Zero. 

 

Open the dfs2 file either by double-clicking on the file (opens a new instance of MIKE 

Zero) or simply from ‘File -> Open -> *.dfs2’. 

 

Dfs2 files can also be loaded into MIKE View as an added file to a MIKE 11 result file. Try 

to open the result file from this simulation and add the dfs2 file produced to the view 

through ‘File -> Add Dfs2’. 
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6.2 Additional Mapping Tasks 

Create additional 2D Map output files from your own selection (Location, Type of Output 

etc.) 

 

In particular, try to make a ‘Dynamic’ map of a result item. 

 

Try and save a DEM output as well. 

 

Investigate the map output files in MIKE Zero with the Grid Editor. 
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7 Applying Rainfall-Runoff Input to River 

Additional water from un-gauged tributaries and catchments along the Sesupe River can 

be included by use of inflow from a Rainfall-Runoff calculation. 

 

7.1 Simple RR Simulation (NAM Model Setup) 

To illustrate this, make a simple NAM setup and run a NAM simulation for the entire 

Sesupe river catchment. 

 
1. Create a new RR parameter file.  
2. Insert new catchment (NAM model). Name it Sesupe. 
3. Input-parameters for the NAM simulation: 

- Catchment area 4800 km
2
  

- In this exercise keep all variables equal to default values 

- Rainfall time series: ‘Time series\Prec_Kybartai.dfs0’ 

- Evaporation time series: ‘Time series\Evap_corrected_summer.dfs0’ 
4. Make a new simulation file for the RR/NAM simulation.  

Activate the Rainfall Runoff simulation only and include the RR parameter file. 

- Simulation time step: 12 hours 

- Set the simulation period to default. 

- Save daily results. 

Run the simulation and investigate the results in MIKE View. Note that you get an 

additional result file too. 

 

7.2 Couple RR Input to River Model through Network File 

7.2.1 Run HD and RR models in parallel 

1. Rename your RR simulation created before and change the model type to HD and 
RR. 

2. Use the network file with weirs ‘Sesupe_Weirs’ as input for the network. Rename it 
before end. 

3. Open the network file 
4. In the network file, distribute inflow from the Rainfall-Runoff simulation at the 

following reaches: 

- Sesupe ch. 0 – 58750 m (estimated sub-area: 300 km
2
) 

- Sesupe ch. 58750 – 109200 m (estimated sub-area: 400 km
2
) 

- Sesupe ch. 109200 - 154075 m (estimated sub-area: 480 km
2
) 

 

To add the RR inflow to the river network, open the network tabular view and go to the 

Runoff/groundwater links > Rainfall-runoff links. 

 
5. Save the network file (with a different name). Add the other necessary files (xns11, 

bnd11, hd11) and edit the simulation file so that the simulation parameters are the 
same as ‘Sesupe_Weirs’ setup. 

6. Run the simulation and compare results to previous simulations (without additional 
catchment inflow). 

 

With this setup, you are running the Rainfall Runoff model and the Hydrodynamic model 

in parallel. It is also possible to run both models ‘decoupled’. The RR model is run before 
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hand and the results of the RR simulation are used to run the HD simulation. You can try 

this in the next step. 

 

7.2.2 Use the results from a previous RR simulation for HD run 

1. Rename your simulation file. 
2. Under the Models tab of the simulation, deselect the box for Rainfall-Runoff. 
3. Under the input page, at the bottom, browse for your RR results from the previous 

run. 
4. You can now launch the simulation. Only the HD model will be run, using inflow from 

the results of the RR model. You can speed up your simulation time for large setups 
in this way. 

5. Additionally you can check that you get the same results as with the previous run. 

 

7.3 RR Input as Boundary Condition to HD Model 

You can also use the RR results as input boundary to the HD model, defined in the 

boundary file. For that, the easiest is to change the extension of the res11 result file from 

the RR simulation to dfs0 so that you get a time series that you can use in the Boundary 

Editor. 

 
1. Make a copy of the RR result file and rename it to dfs0. 
2. Open the simulation file ‘Sesupe_Weirs’ and rename it. Also remember to rename 

the result file. 
3. Open the boundary file and rename it too. Load it in the simulation file. 
4. Find the source inflow for the Jotija tributary and select the RR input. We want only 

5% of the total input so you need to edit the time series so that only 5% of the total 
discharge goes into the tributary. 

5. Save the boundary file and run the simulation. 

6. Verify that the results you get are as expected. 
  



Applying the Climate Change Tool to the Model  

 69 

8 Applying the Climate Change Tool to the Model 

Since release 2011, MIKE Zero includes a Climate Change scenario modelling tool. This 

tool can be used in combination with MIKE 11 setups in order to generate new MIKE 11 

setups based on selected climate change emission scenarios. 

 

The Climate Change tool is based on the CO2 emission scenarios developed by the 

Intergovernmental Panel on Climate Change (IPCC). 

 

In this exercise, you will apply an emission scenario to the HD-RR setup created in task 

2.2 to generate a new scenario run for evaluating the impact of climate change on the 

Sesupe River. 

 
1. In MIKE Zero, open a new Climate Change file (*.mzcc) from the MIKE Zero product 

list. 
2. Browse for the base model setup (HD-RR setup). 
3. Select a folder where the new setup files should be saved. 
4. Set the location of the model to Latitude 55 deg and Long 22 deg. 
5. Under Climate Change Scenarios, add at least one climate change scenario. 
6. For each scenario, select which Global Circulation model you would like to use (you 

can choose more than one Global Circulation model); select a CO2 emission 
scenario and finally specify the scenario year. 

7. Click ‘Generate default delta change values’. Go to the following pages to check the 
delta change values that will be applied to the input time series of your model. For 
precipitation, a relative adjustment will be applied. For the air temperature, an 
absolute adjustment is applied. For evaporation, a function is applied based on the 
temperature. For the sea level, an absolute change is applied. 

8. Generate the climate change scenario. In this step, new time series, boundary, RR 
and simulation files are created for the climate change scenario. 
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9. Open the new climate change model and observe the updated time series, RR and 
boundary files. When ready, run the simulation. 

10. Create as many scenarios as you like and compare then results in MIKE View to 
evaluate the impact of climate change on the Sesupe River. 
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9 Advection-Dispersion Simulations 

9.1 Advection-Dispersion parameters 

In this section, you will include the computation of advection and dispersion of two 

components all along the river Sesupe. 

 

First of all, create a copy of the ‘Base_Simulation’ folder, and rename it ‘Advection-

Dispersion’. Then create a new Advection-Dispersion file for MIKE 11. Save it in the 

‘Advection-Dispersion’ folder, and give it a meaningful name. 

 

In the first tab, define two components. You can for instance call them ‘Pollutant1’ and 

‘Pollutant2’. Define their units in g/m
3
, and a normal type. 

 

 
 

In the Dispersion tab, you will then define the dispersion parameters. Set the Dispersion 

factor to 15. Set the exponent to 0, which means that the dispersion coefficient will be 

constant (refer to the F1 help to get more information). Hence, you don’t need to change 

the minimum and maximum dispersion coefficient. 

 

In the Init. Cond. tab, you will define the initial concentrations along the river. Apply a 

constant initial concentration of 0 for ‘Pollutant2’. For ‘Pollutant1’, we’ll apply a varying 

initial concentration, with a linear interpolation between 25 g/m
3
 at chainage 0 m and 35 

g/m
3
 at chainage 270500 m. 
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In the Decay tab, we want to apply a global decay of 0.5 h
-1

 for ‘Pollutant2’, and no decay 

for ‘Pollutant1’. 

 

 
 

Leave the Cohesive ST and Sediment Layers tabs unchanged. These tabs are only used 

when the component type is set to Single Layer Cohesive or Multiple Layer Cohesive, 
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instead of Normal in the first tab. In such cases the component represents cohesive 

sediments, carried over as suspended matter, and the Cohesive ST and Sediment Layers 

tabs may be used to include deposition and erosion in the calculation. 

 

In the Additional output tab, select additional items you want to save in the result file. Here 

we will select Grid Mass, which will provide the instantaneous mass in each calculation 

point. 

 

 

9.2 Define boundary conditions for pollutants 

We now need to edit boundary conditions, in order to specify which concentrations enter 

the model domain. 

 

At the upstream boundary, we want to apply a constant concentration of 25 g/m
3
 for 

‘Pollutant1’, and 0 for ‘Pollutant2’. Hence, tick the ‘Include AD boundaries’ option for the 

upstream open boundary. Then use the TS-defined mode in the AD boundaries column, 

in order to manually define the concentrations. Finally, set the concentration values for 

both components in the lower table. 
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For the downstream open boundary, simply do the same changes. Note that the applied 

concentrations for this boundary will only be used during the simulation if the water comes 

into the domain from this boundary, meaning that the water would flow from downstream 

towards upstream. In this example, this won’t appear and thus you can apply any 

concentration values you want. 

 

We won’t add any pollutant sources as point sources or distributed sources in this case. 

 

9.3 Run the simulation 

The last step is to edit the Simulation file. In the first tab, activate the Advection-

Dispersion module, and browse to the Advection-Dispersion parameter file on the second 

tab. 
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In the Results tab, specify a name for the Advection-Dispersion result file. 

 

Then start the simulation. Decrease the simulation time step if you get a warning 

concerning the Courant Number. 

 

Finally, open both result files, containing default and additional items. Analyse these 

results by plotting time series as well as longitudinal profiles. 
  



 MIKE 11 HD 

76 River Model Setup and Modules Application Manual - © DHI 

10 Water Quality Simulations (ECOLAB) 

In this exercise we will make Water Quality simulations using the ‘Sesupe_Base’ river 

model setup previously prepared. 

 

Time step used for the following WQ simulations should be 2.5 minutes. 

 

Saving frequency can be set to 24 time steps (= every hour) 

 

Simulation period: 1/7-1997 – 1/9-1997 

 

10.1 Constant Boundary Simulation – Excluding Processes 

1. Create a new WQ parameter file (= Ecolab11 file). 
2. Load WQ Level 1 Template (simplest BOD/DO relation template). 
3. Disable processes. 
4. Create a new AD11 file with ‘dummy’ component (required in order to make WQ-

simulation!). 
5. Update Boundary conditions: 

a. Inflow (ch. 0 m) 

- DO = 10 mg/l.  

- Temp = 15° C and  

- BOD = 1 mg/l 

b. Outflow (ch 270500 m) 

- Open Transport Boundary  

- Conc for all components = 0 mg/l  

- Temp = 15° C 
6. Run the simulation. 
7. Open the results in MIKE View and check if they are as expected. 

 

10.2 Constant Boundary Simulation – Including Processes 

Use the same simulation characteristics as described in exercise above. 

 

But now, we will run with Processes Activated instead. Therefore, activate processes in 

the ECOLab file. 

 

Run the simulation (ideally, make a new sim11 file and a new ECOLab11 file) 

 

Load the results and compare to previous simulation. 

 

Any differences? 

 

10.3 Time Series Varying Inflow Boundary – Excluding Processes 

Use the ECOLab11 file with Processes disabled. 

 

Adjust the boundary conditions such that time series varying data are used at the inflow 

boundary. 
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The time series file ‘WQ-Exercise-Data.dfs0’ should be used. 

 

Select the appropriate Items for each of the 3 components in the WQ simulation. 

 

The outflow boundary is kept unchanged. 

 

Save the boundary file with a different name. 

 

Include this boundary file in the simulation file and save the sim11 file with a different 

name. 

 

Run the simulation. 

 

Open the results in MIKE View and check if the results are as expected. 

 

10.4 Time Series Varying Inflow Boundary – Including Processes 

Use the same simulation characteristics as described in exercise above, but now Activate 

processes. 

 

Run the simulation (ideally, make new sim11 file and new ECOLab11 file) 

 

Load the results and compare to the previous simulation. Any differences? 

 

10.5 Time Series Varying Inflow Boundary & Point Source – Including 
Processes 

Use the same simulation characteristics as described in the exercise above. 

 

Open the boundary file. 

 

Add a point source at location Sesupe 116500 m. 

 

The point source is defined by a discharge time series using the file ‘Tributary-

Inflows.dfs0’ and choosing the TS item named ‘Kirsna_outflow_sim’. 

 

A constant concentration should be defined at this point source (to represent a kind of 

background concentration from tributary). BOD point source = 20 mg/l. 

 

Save the boundary file with a different name. 

 

Run the simulation with the new boundary file (ideally, make new sim11 file and new 

ECOLab11 file). 

 

Load the results and compare to previous simulation. 

 

Any differences? 
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11 Sediment Transport Modelling 

To be included  
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